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4 Introduction

Introduction

Whenever a new computer is introduced nowadays (and it does not have to be a
“compatible”), the manufacturer cannot afford to release it without providing some degree
of multitasking. No operating systems for any computers are being developed without the
ability to run several programs at once.

The original GEM concept implemented in the Atari ST was a single tasking operating
system with some primitive elements of cooperative multitasking. MagiC replaces this with
its own high-speed operating system, giving the Atari ST/STE/TT and Falcon 030 series all
the advantages of preemptive multitasking.

MagiC’s preemptive multitasking allows the user to start several programs, switch between
them at will and, while another program is calculating in the background, carry on working
with yet another in the foreground.

In contrast to other solutions, the primary objective during the development of MagiC was
to implement this without any pay-off in speed. You don’t have to buy a new 400 MHz
computer to enjoy the benefits of “real” multitasking - your old 8 MHz Atari ST is quite
capable of running MagiC.

Features of MagiC
The following list is just a brief selection of possibilities offered by MagiC. Its scope can only
be realized after reading the handbook thoroughly.

« Both applications and accessories run in a preemptive multitasking environment.

» Tasks can be switched either from the keyboard or by using the mouse.

 Up to 64 windows can be open at the same time.

« The desktop MAGXDESK has been developed especially for use in a multitasking
environment. It supports parallel copying, deleting and formatting, a non-blocking
search function for files as well as many other comprehensive functions.

« Text-mode applications (so-called TOS or TTP programs) run in windows.

« Extended dialog functions, additional system calls for flying dialogs, pop-up menus,
dialog-windows, scroll boxes are a part of the OS.

* A new file selector and font selector are available throughout the system.

« MagiC supports symbolic links (aliases) and piping (useful for drag and drop). There is
also an interface for loading file systems and device drivers.

« Close compatibility with TOS; critical programs can be run in single tasking mode.

« Programs are executed much faster than under the original system - all system functions
have been optimized for speed.

» Proportional fonts can be used as system fonts for dialog boxes and windows.

« The window manager supports solid dragging and resizing of windows. Windows can
also be shaded and moved out of the left side of screen.

« MagiC supports shared libraries to use memory more efficient (e.g. the new window
manager, the system editor and the printing dialogs are shared libraries).

* The file system is Windows 95 compatible (VFAT) and capable of using long file names.

» The messages of auto folder programs can be saved in a log file.

« MagiC supports threads and signals for efficent multitasking.
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Hardware Requirements
MagiC will run on any of the following Atari computers: ST, Mega-ST, STE, Mega-STE, TT or
Falcon 030. TOS must be in ROM, but this applies to all Ataris since 1986.

A hard disk is required. Theoretically, MagiC will run with only 512 Kb main memory, but at
least 2Mb is recommended for a good working environment. The graphic system
accelerator NVDI is highly recommended to improve the speed at which the screen is
drawn. It also provides your Atari with new printer drivers and vector fonts.

Installation

First of all, you will have to fill in the registration form and send it to your MagiC distributor.
Only then will you be eligible for our update service. Place the original disk in drive A: and
start the program INSTMAGC.PRG. The following dialog box will appear:

\ HagiC 6 - Installation I

Serial number: 123456789.

Name | Else|B|ttenherg__.____ ————————
Address: Main Street 1, Windsor SEI RS - UKo

prive ¢ [AIBMMO[EIFIGIA[I]JIKIL.
Extras ! | INSTALL

Enter the serial-number EXACTLY as it appears on the disk-label - if you make a mistake the
installation will not work. Write in your name and address. Drive is used to select where you

want MagiC to be installed. This should usually be drive “C:”. If you select INSTALL Extras
the install program copies further files and programs in the directory EXTRAS which could

interest advanced users.

Check again that the serial number is written correctly and confirm the Install button.

Starting MagicC

MagiC will be loaded automatically whenever you press the reset button or use the warm-
start key combination - MagiC is “reset resident”. Cold-starts (e.g. switching on the
computer) will load MACXBOOT.PRG first. This in turn loads MagiC and then calls a warm-
start. MAGXBOOT should be one of the first programs in your AUTO folder to be loaded
(i.e. the running order should be something like MAGXBOOT, NVDI, ... ). If you do not own
a boot-selector you may have to copy programs into a fresh AUTO folder to get the order

right.

Holding down both Shift keys while booting will prevent MagiC from being loaded. The
combination Ctrl-Alt-RShift-Delete will cause a cold-start so that you can boot from another

drive or use both Shift keys to skip MagiC.
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First Steps - Using the MagiC Desktop

A freshly installed MagiC Desktop will present you with the standard icons:
MADXDESK File View Options Objects HHHE >

mwwmmmmm

You will see an icon for every disk drive currently installed and one each for printer and

trashcan. Drives A and B are depicted as floppy disks and all the other partitions as hard
disks. You can change these icons by clicking on them and selecting Define Icon from the

Options menu.

Single-clicking an Icon will select it. Clicking and holding will let you move it, double-
clicking will open anything but the trashcan or printer. All disk drive icons are named after
the corresponding partition. Unnamed disks will be given a default name, e.g. “DISK”.

The Desktop Windows

A double-click on a disk drive icon will open a window showing the contents of the chosen
drive:

MAGXDESK File View Options Objects L S
H H ;e moem s o=

OISK IR DISK JRIBH-H234.ARRIEH-HZD4 .DHRIBN-H234.CRIPH-H234 .08 OISk BTRASHCANE PRINTER |

s I =" AR
630.797 Bytes in 29 nb ects o 8,1MB free

T O 9 O F

AUTO CLIPBRD COMNMECT CPX EDC1TC

N
Y

3
Y
N o - JO I B
N S =R =

BOOT . LOG Eﬂ"l ACC HODRIVER . HYPTRER .ACC HMAGIC .RAM MAGX , [ NF ST-GUIOE .ACC -?/

_—

The information bar shows the number of objects in the window, how much memory all the
files use and also the amount of free space on the partition. Clicking anywhere on the
information bar will open an alert box showing the amount of free space in bytes. The
vertical scrollbar can be moved either with the mouse in the usual GEM manner or by
holding down the cursor keys; Shift together with a cursor key will scroll pagewise - Home
and Shift-Home will scroll to the top and bottom respectively.

If you click on an object in a window, the information bar will show the size, date and
attributes of the selected file. The abbreviations for file attributes have the following

meanings:
R read only
S system
H hidden
A archive
E executable
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If you select several objects at once, the sum total of their sizes will be shown (e.g. so you
can easily find out whether they will all fit onto a single floppy disk). If you insert a different
disk and update the window (by pressing Esc), all directories will be updated and any
invalid ones will be quitted so that you will not be left with a blank window (unless of
course the disk is empty!).

The fuller adapts the size of the window to its content. If you activate Options: Preferences:
Show parent object the closer will close the window immediately. You can use the parent
object to enter the parent directory level.

New Elements

Besides the usual window elements, you may have noticed an extra button next to the @
fuller. This is the Backdrop button which sends the window to the back of the pile.

Another will become topped. There are many situations where use of this button is much
faster than either cycling through the windows by pressing Ctri-W or tediously moving
several windows around until you finally find the one you are looking for.

Iconify
Newer programs may also let you iconify windows:
s AR { o0 a

76

15 !“Et 61 %-jts A §
=

ATARILS .INF ATARILS .5VS CAMNON . I 7 CAMNOMN .SVE COMMECT .FNT

4 B i )

COMMLIGH .FNT ESCPE.INF ESCPFR .SVS I . The I . EYS
r

2 N I I I I Iy I

MEMORY .SVE META .SYS HFEALS .BYS MFAR .SVE MFAZSS . SVE

/i

This button (the Iconifier) is used to reduce the size of the window to a minimum and place
it at the bottom of the screen. If you hold the Ctrl key at the same time, all the windows
belonging to the program will be iconified. Double-clicking the minimized window restores
its original size. Unlike the Backdrop button, this feature must be actively supported by a
program, so you should expect it not to appear when you are running older applications.

Window Shading
Double-clicking on the window title bar reduces the window to the title bar.
\ITIL) == 0Af| ——————p |0 L |

Jbjects  8,IMB free

S . OF

. &EXT CRASHOMP . TOS DUM®.TTP
FC.TTP LABEL :TTF LIMITHEM.TTFE MEMEXAMN.TTPF

. s

HMOMOTICE .TXT SPLIT.TTP UFATCONF .,FRA UFATCONF REC ,gr

35.406 Bytes in 1

This is especially useful when you just want to take a look at a window in the background.
Double-clicking the title bar again restores the original window. Unlike the Iconify button
this feature is available in every program that uses GEM windows.
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Operation of Background Windows

A very practical feature of good window-based multitasking systems is that even windows in
the background are able to react to mouse clicks. Fuller, sizer, scrollbars etc. of background
windows are all directly operable under MagiC, which can save you quite a lot of time
compared to poorer systems where you have to top the window first. Some older and not
very cleanly-written programs have trouble handling operations on background windows
(especially scrolling). If a background window doesn “t react you will have to top the
window first.

The Appearance of Files in Windows

Would you prefer files to be shown as Text instead of icons? DOS fans (and others) should
take a look at View in the menu bar. If as Text is selected, the settings for system font size
and additional file information such as the date, size and time will apply. As long as the
window is wide enough, MAGXDESK will display more than one column - this feature can
be defeated by ticking View: Single Column.

It may be difficult to find a particular file when a large number are displayed at once.
MAGCXDESK helps out by letting you set a mask for each window - this determines which
files will be visible. Select View: Set Mask from the menu bar and enter the mask “*.ACC”
for instance. Any files which don’t have the extension “ACC” will be filtered out of the
window. The mask accepts normal GEM wildcards i.e. “*” means any number of
unspecified characters and “?” means a single unspecified character.

Files in a window are always sorted according to certain criteria. The method of sorting can
be changed by setting one of the following (in the menu bar under View):

by Name

« by Date

* by Size

» by Type (extension)

e unsorted

The entry unsorted may need explanation. If this is ticked, the files will be shown in the
order in which they physically appear on the partition. This feature can be very helpful as it
shows you the order of files in the AUTO folder (which are loaded in this order). The current
setting is also displayed in grey capitals in the menu bar.

Placing File Icons on the Desktop

As well as the standard desktop icons, any file or folder icons can be dragged out of a
window onto the desktop. This lets you start programs or open folders immediately without
having to click your way through several directories first.

If a window icon is dragged onto the desktop and the mouse button is released, a copy of
the icon will appear in that position. You can then treat it almost exactly as if it were the one
in the window (i.e copy, start a program, etc.), with two notable exceptions: Firstly, all
desktop icons can be repositioned within the desktop. Secondly, you can’t delete a file by
dragging a desktop icon onto the trashcan - only the icon referencing the file will be
removed. The maximum number of icons on the desktop is unlimited. However, experience
will teach you that it is not very sensible to plaster the whole desktop with file icons. The
desktop becomes cluttered and the whole purpose of this feature (speed through
recognition) would be lost.
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Copying, Moving and Deleting Files

Copying

Dragging a window icon into another window, onto a folder or drive icon will copy it to
that destination. You can even drag it to ——— File Operations
another position within the same window if T o

you need a backup copy - an alert will Copying Files

appear in which you can rename the copy. If ARSI,

you wish to copy the complete contents of a ~ Files:

window to another, you can activate Select ~ Folders:

All from “File” in the menu bar and then kBytes:

drag as usual. _ Nade

The complete contents of a drive are more @ Confirm

easily copied by dragging the drive icon to ) Backup Mode

@ tl_gerurlte

the required destination than by selecting all O aenme

files from the root window. Note that this is
still a “file copy” and not a “disk copy” (see
“Copying Floppy Disks” below). MAGXDESK
opens a dialog box showing the number of
files and folders and also the approximate
number of kilobytes to be copied.

Below this information you can set the required mode:
» Confirm: The user will be warned before a file of the same name is overwritten.

« Backup: All files of the same name but with an earlier date stamp will be over- written
without warning. Those with a later date will be skipped over or deleted

(whilst moving). Note that, even if the target directory is full, this mode will
not display warnings!

« Overwrite: All files of the same name will be overwritten without warning.
e Rename: All files and folders can be renamed before they are copied or moved.

Moving
Moving one or more files is effectively the same as copying and then deleting the originals.
The motions are also the same as copying except that the Ctrl key is held down first.

MAGCXDESK displays what it is doing while it is e ane anflitt el
copying, moving or deleting, i.e. which file or RN S B RS
folder from which drive etc. If there is already a f.!!,!.ﬂ.!..l_"sﬂ__!ll_“"“ __._j_-:.,_.;._-.".:..._'.;_"

file of the same name in the target directory, Bl‘lyillll n!m [CONNECT .FNT
the following dialog box will appear: New llg!g‘ CONNECT .FIIT]

This gives you the chance to rename the copied m _ -

file, to overwrite the original file or to skip the
copy.
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The following dialog box will appear if the names of folders conflict:

| au 1 Name: [SPOOL___.___
rig g;' II::;‘ E...

—m—

In this case you have the choice of either using the existing folder (files in the source are all
copied into the target folder), changing the name of the new folder or aborting the action
altogether.

MAGCXDESK uses a very refined algorithm to find out whether there will be enough space
on the target drive to accomodate the copy - before copying begins. The irritating message
“Not enough room on disk A:” after 37 files with four files to go is a thing of the past.
MAGXDESK warns you beforehand - you should only ignore the warning if you’re sure that
enough of the original files will be overwritten by new ones of the same name.

Deleting

Files and folders are deleted by dragging icons onto the trashcan or by selecting File: Delete
from the menu bar. A dialog box appears before MAGXDESK starts deleting, informing you
of the number of files and folders to be deleted and their total size in kilobytes (which
indicates how much space you will save on the medium after carrying out the operation).

Even while files are being deleted or copied, pressing both Shift keys at the same time will
cause the action to be aborted as soon as possible. If you find the warnings during these
actions irritating, you can turn them off globally within the dialog box called by selecting
Options: Preferences in the menu bar. But remember - without these warnings you could

accidentally lose a lot of important data!

Creating a Symbolic Link (Alias)

The MagiC file system includes the ability to create references to programs, data, folders or
drives which actually exist in other directories or drives. Such references are called
“Symbolic Links” or “Aliases”.

Instead of copying a program into a folder, you can create a symbolic link to the program
and its data. The advantage of a symbolic link over a normal file copy is that they require
less memory: the link is only a reference to the original and is therefore very short. Changes
made to the original file (e.g. a complete update or edit os the source file) are immediately
adopted by the symbolic link.

Creation of a symbolic link for a file, folder or drive is simple: hold down the Alt key before
pressing the left mouse button on the icon and then drag the icon to the required
destination (drive, folder or window). A dialog will be opened which displays the number
of files and folders and their sizes. A symbolic link in a window is easily recognisable
because MAGXDESK changes the style of the object name to cursive. Symbolic links can be
removed by simply dragging the icon onto the trashcan.
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Renaming Objects

Files, folders and drives can be renamed. Select a file, folder or drive icon and call
Information from the “File” menu. See the chapter about the MACXDESK menu structure
(in the section “File: Information”) for a detailed description of object-specific information.

Formatting and Initialising Drive Media

Before you can write data to a brand new disk it will have to be formatted. Select the floppy
disk icon and then Format from the “File” menu. The following dialog box will appear:

— Msk-Parmters:- :
' § Sides: O 1 &1

rmmsue: =[88 +
'Sectarsil’radu ﬂﬂ _.E_ _,L_]

As you can see, besides being able to set formatting parameters (number of sides, tracks per
side, sectors per track and density) you can also give the disk a name which will later
appear under the corresponding drive icon. Formatting erases the entire disk and looks for
damaged sectors. Any data previously on the disk is therefore lost forever. If the formatting
program keeps giving you an error message (e.q. defective sectors) then you should throw
the disk away to be on the safe side.

Formatting begins at the highest track, so that if you suddenly realize you are formatting
over important data, you still have a good chance of retaining some of it by pressing both
Shift keys as soon as possible. If you only want to clear all files from a disk which is already
formatted you can use the button Init. This only erases the file allocation table and is
therefore much faster. If you attempt to format a hard disk partition, an alert will appear
giving you the choice of initialising the partition or aborting the action. MAGXDESK cannot
format hard disks - this is the domain of specialized hard disk utilities (HDX, SCSITOOL etc.).
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Copying Floppy Disks

The ability to make safety copies of your floppy disks is very useful for backing up data.
Selecting Copy Disk from the “File” menu will open the following dialog box:

A m g g o p g s e e o ey e

.—mw———-ﬁﬁ-—‘u‘.‘h—-ﬁ-——

Source: @ l)estinatim m

- Mode -
.I %g ith Feraattln

ithout qutglnh! e

This function is not the same as dragging one floppy disk icon onto another (that would
copy each file one after the other) and it only applies to floppy disks. Drive A is assumed to
exist. Clicking on the drive character will cycle through the registered floppy drives.

For the sake of speed, the MAGXDESK copy program uses an algorithm that analyses the
current format of the source disk and reformats the target disk accordingly if the two differ.
If the radio button Without Formatting is selected, the action will only be carried out if the
formats of the two disks match. If you are working with only one floppy drive you will be
asked to insert the target disk. When the program compares the formats and sees that they
differ, an alert will be opened giving you the choice of either reformatting the target disk to
match the source disk or aborting the action.

If your computer has both a floppy disk and a hard disk, but not enough memory to be able
to read a full disk, you can still use MAGXDESK s copy program to load the disk without
having to play “disk-jockey”. Click on the Options button and enter a hard disk drive for
Temporary drive used. If there is enough room on the hard disk, the source disk will be
read completely and then written as a single file to the temporary drive. You will be asked
to insert the target disk. The temporary file will be written out and then deleted. If there

isn "t enough room in memory or on the temporary drive to allow using this method you
might have to swap the disks several times. Disk copy can be aborted by pressing both Shift
keys at the same time.

Displaying Files

MAGXDESK lets you specify an application used for viewing all files whose extensions aren“t
registered via Options: Install Application. There is a program on the disk (MGVIEW.APP)
which displays text files in windows. Instead of using this program (especially if you want to
be able to view several different formats - text, images etc.) you can specify an different
viewer under Options: Preferences in the category Utilities. Well known shareware viewers
are “1st Guide” and “GEMVIEW”.
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Starting GEM Programs

Now that you have a general idea of the scope of MAGXDESK you will probably be wanting
to see multitasking in action. The easiest way would be to double-click on program icons,
but you will soon learn that there are other methods which can be more suitable.

Many applications accept a file name as argument, and this is achieved under MAGXDESK
by dragging one or more file icons onto a program icon. For instance, a graphics program
which accepts an argument would start and load the file that was dropped onto it
automatically. Not all programs react this way, but the newer ones usually do - just try it
and see!

You can start more applications by clicking in the MAGXDESK windows, providing that they
are still visible. Unfortunately, there are still some programs on the market which register
their own desktop, effectively making the MACXDESK windows/icons unavailable. That
brings us to the next topic - switching between programs.

Switching between Programs

The simplest way of switching programs is to click anywhere in a window belonging to the
program you want to activate. MagiC tops the window and switches the menu bar. It may
seem confusing at first, but you will soon get used to seeing the desktop and windows
belonging to other applications. Multitasking is more “real life” than singletasking - taking a
second look at your real desk will convince you of this.

... using the Popup _
Clicking on any “unused” area in the menu bar will open a MAGXDESK
popup. vV SLEEPJOE

e, ghon, gl gk, gl gl Mgl ol il digh, iR, e, PR, el R, o, ik, Gl ol g, AglR, WG R

SLEEPJOE hide

At the top are the names of programs in memory which have athers  hide

a menu and/or desktop background. The application whose

o all unhide
menu/background are currently active is ticked. Programs @re [ . v va v v v o v vn e v
switched by clicking on the program name. The menu barand | tjdy up
background will be switched accordingly. Programs written start progran...

with multitasking in mind will not have their own destop! | 1882 kBytes free

... using the Keyboard
The key combination Ctrl-Alt-Tab will cycle through all active applications. Hold down Ctrl

and Alt, press Tab repeatedly until the small box in the centre of the screen displays the
name of the program you want, then release all keys. |

Hiding and Unhiding Programs

The more programs you start simultaneously, the more cluttered your screen will become,
especially if it is small. The MagiC popup has a few handy features to help in this situation,
so you are not forced to close windows which you may need later.

Program hide
This will hide all windows/background belonging to the currently active application and

then switch to the next application.
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Others Hide
All windows belonging to programs other than the currently active one will be hidden.

Note that the hide function does not actually close the windows but only moves them
offscreen. This means that hidden programs are not terminated, but are still at the
“multitasking party”, in the other room so to speak. We chose this method to allow older
programs to benefit from this function, avoiding any special handling routines. The
application is sent a message that the user has moved the window offscreen - any older
programs which do not respond in this way will ignore the message and the window will

remain visible.

Unhide All

Any hidden windows will be made visible - this entry will be greyed if there aren’t any.
Applications with hidden windows are marked in the popup with an asterisk. Switching to
programs with any windows offscreen will of course restore the windows to their original
positions.

Tidy Up

This will redraw the whole screen. If you have started a program which has left “droppings”
or even messed up the whole screen, all you have to do is move the mouse pointer up to
the menu bar and select tidy up from the popup. (Tip from the translator: Clicking on the
top left pixel of your screen will always call the MagiC popup even if the menu bar is

invisible).

Start Program...
If at any time you aren“t able to get to the desktop easily, you can start another program

from the file selector. Programs set to single-mode using Options: Install Application will
not be started.

XXXX Kbytes Free
The bottom line of the popup displays free memory. This is useful for checking whether you

have enough memory to start yet another program without having to terminate one. Note
that some programs reserve as much memory as they can get.

Starting TOS Programs

Programs with the extension “TOS” or “TTP” are called generically “TOS programs”. They
differ from true GEM programs in that they don“t use any graphic elements - their inputs
and outputs are pure text. In MAGXDESK, TOS programs can be started in the same way as
GEM programs with a double-click. Programs with the extension “TTP” (TOS Takes
Parameters) will also accept arguments. If a TTP program is started with a double-click,
MAGXDESK will open a dialog box in which you can enter any arguments you want to send.
If a TOS program is started by dragging one or more file icons onto the program icon, the
file name(s) will automatically be sent as argument(s) and the dialog is not opened.

Because you are working with a window-based system it would be more than irritating if
the output of a TOS program would appear on top of your windows. Besides, you may want
to start more than one TOS program in the multitasking environment (e.g. a packer and a
raytracer). The obvious answer to this problem: divert the output (and input) of all TOS
programs to a window!
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This redirection is handled by the program “VT52”. It provides a window for each TOS
program you start, letting them run simultaneously without allowing conflicting inputs and
outputs. A practical side-effect of this is that TOS programs have some of the functionality
that was previously reserved for GEM programs i.e. clipboard support, output scrolling, font
selection etc. For more information read the section on “VT52 menu structure”.

Accessories

A word about accessories. Although these programs go against the MagiC philosophy, they
are fully supported. Accessories are listed at the far left in the menu bar as usual. Accessories
can always be loaded via double-click in MAGXDESK as long as there is enough room in the
list MagiC is able to remove some accessories - hold down the Ctrl key before clicking on
the entry to find out whether the accessory is removeable.

Switching off the Computer

Computers running muititasking operating systems shouldn’t be simply switched off while
applications are still running. Even a reset (pressing the Reset button or Ctri-Alt-Del) is
taboo. On the contrary, you should ensure that all files are closed and that all programs are
terminated correctly before reaching for the power switch, otherwise you run the risk of
losing data!

MagiC includes a “shutdown” mechanism for this purpose. This function is called in
MAGXDESK by selecting Shutdown from the “Options” menu. Each program in memory is
sent a message asking it to terminate. If one ore more applications don’t respond to this
message (and are still running) after a certain time, SHUTDOWN displays an error message.

The key combination Ctri-Alt-Del is intercepted by MagiC. It will cause a normal system
shutdown if you are running MAGXDESK - the same as selecting Shutdown from the menu.
A further Ctrl-Alt-Del at this point will call the standard reset routine.

Configuring MagiC

MagiC has a number of options. To allow you to configure MagiC easily, a number of
control panels (CPX modules) have been included. To run the control panels you need a
special program, e.g. COPS (supplied with MagiC).

COPS - COntrol Panel Server

During the MagiC installation COPS is copied into the root directory of the start-up disk.
COPS can be run from the Accessory menu under the entry Control Panels.

N/ FON T
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By double-clicking on one of the icons in the window, the corresponding control panel can
be opened. A right-click on an icon opens a popup menu, where you can activate or



16 Configuring MagiC

deactivate the module and obtain information about it. A right-click in the window
background opens a popup menu where you can select various settings (e.g. “Directory for
Control Panels”).

MAGXCONF
This module lets you set a number of default values for :
MagiC. The MAGXCONF switches have the following | - H“m 6. BL / 18 87.1998
functions: | X Fastload

| , Rl 10S Con atlhlitn
Fastload ' Smart &edrlﬂ i
Switching this on will increase the speed at which 5" | g&ﬂf df"‘::::":‘ d'ﬁ:‘
floppy disks are read. Fastload should be left on except ~ad Flllldlllli né us
if you are having difficulty with read-errors. The status e
of this switch is harmless anyway because it only

affects disk-reads and not writes.

TOS Compatibllity

As several programs can run simultaneously under MagiC, strict data security measures
have to be taken because a single file would otherwise be accessible for write operations to
more than one program at the same time. Unfortunately, there are still programs in
circulation which make erroneous system calls, and these can cause multitasking systems no
end of confusion. The switch TOS Compatibility allows the user to turn off the MagiC
security measures so that such faulty programs will run. Needless to say that this switch
should only be turned on when absolutely necessary, and then only for short periods!

Smart Redraw

This switches into a mode in which the screen will be redrawn at a much faster rate. To get
the feel of this setting switch Smart Redraw off, change to text-mode by ticking View: as
Text in the MAGXDESK menu bar and finally enlarge a MAGXDESK window. If one of your
programs tends to forget to redraw parts of the screen (because it doesn "t get on with
Smart Redraw) you should turn this off.

Grow and Shrink Boxes
Switching this off deactivates the implosion/explosion effect seen when opening and
closing windows. Used to speed up display.

Floppy Background DMA

MagiC is able to read, write and format floppy disks in the background. This means that you
can carry on with other tasks at the same time. This switch activates or deactivates floppy
background DMA. Note that ST and Falcon 030 computers need a special hard disk driver
with this capability (HDDRIVER). Contact System Solutions for further informations.

Pulldown menus
Changes menu handling to pulldown menus.
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Preemptive Multitasking

This term has only been mentioned in passing at the beginning of the manual and requires
further explanation before moving on to the next configuration module.

The average computer contains only one central processor, so programs don "t really run
simultaneously. The tasks are simply switched so quickly that they seem to be simultaneous.
The main difference between various multitasking concepts lies in the conditions which
govern this switching (called the “task switch”).

The GEM in Atari’s ROM as well as Windows 3.x for Intel-PCs or System 7 for the Apple
Macintosh only allow a task to be switched when the program currently running makes a
system call. This behaviour is called “cooperative multitasking”. If the current program
doesn "t make a system call for a comparatively long time, the other programs will not get a
word in - so the whole system appears to stumble along e.g. reaction to mouse and
keyboard input is very “clammy”.

MagiC as well as UNIX, OS/2 and Windows NT use an additional “timeslice” method for
switching tasks: Programs are interrupted at regular intervals and switched so that one
program doesn “t reserve too much processor time at the expense of all the others. This task
switch behaviour is called preemptive multitasking. Unlike cooperative multitasking, this
method requires a high degree of task-management which can lead to loss of speed if it is
not implemented well. MagiC implements preemptive multitasking well!

A common misconception is that multitasking systems use up more processor time dealing
with task management than they give to programs, even if there is only one program
running. If a programmer has compile times which are twice as long under a multitasking
system than in singletasking, even a megabyte cache is not going to stop him from asking
whether multitasking is worth the loss of processor time. Luckily, this loss due to MagiC is
far below one percent! Misconception exposed...

Sounds overcomplicated? Don "t worry, you don’t have to adjust very much to MagiC.
Except for a few extra parameters, operation under MagiC is comparable to TOS in terms of
complexity. Under “Vanilla” TOS, you are forced to wait until the computer has finished a
complicated task (e.g. compiling huge sources, raytracing etc.) - now you can get on with
other work (e.g. writing a letter) while the tedious task is still running in the background.
This is especially true of TOS programs as their outputs are redirected into windows.

Unlike most solutions in the multitasking world, MagiC does not use static priority control,
which allocates more processor time for certain programs than for others. The MagiC
method involves giving preferable treatment to the program the user is currently sending
messages to. All other programs (e.g. whose windows are not active) will be treated as
being not quite as important.

This is as simple as it sounds: Even if you are an ace on the keyboard, you will be spending a
comparatively long time looking at the screen and not actually writing anything. MagiC
makes good use of this time by giving it to any programs waiting in the background - you
won “t notice any delays and may be surprised when the fractal (for instance) behind your
text window is finished.
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Some degree of control over the distribution of processor time may however become
necessary. MagiC has two methods which affect this, described next.

TSLICE.CPX

This CPX module has two sliders and a switch. One
slider is used to control the size of timeslices in
milliseconds. The other one regulates the priority-
ratio between background and foreground
processes. A value of 1:1 would be a high priority

and 1:64 a low one.
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Values of Sms to 10ms for timeslices and 1:20 to
1:32 for background priority are good in practice. A
timeslice setting of 5Sms causes a small loss of speed
on 8MHz STs (the system uses too much time for
task switching), and therefore a setting of 10ms is recommended here. Faster computers will
have no problem with 5ms timeslices. The value of background priority has a much stronger
influence upon the behaviour of your computer. Try not to set this value too low, otherwise
the background programs will slow down the foreground one noticeably (an Atari TT
however can handle a value of 1:10).

Switching Preemptive Multitasking off will do exactly that - MagiC will then work with
cooperative multitasking. This should only be switched off if a program is critical.
Preemptive multitasking really does allow programs to run simultaneously without blocking
each other. Even if a dialog box is open in the foreground program, the background
programs (e.g. a packer in a TOS window) will still be given processor time. The dialog box
would halt background programs if cooperative multitasking were used!

The other method of controlling the distribution of processor time can be seen in the file
MAGX.INF. The line #_TSL sets the length of timeslices and also background and foreground

priority.

TIP:  MagiC processes MAGX.INF first and then starts accessories - including COPS.ACC
with the modules MAGXCONF.CPX and TSLICE.CPX if they are installed. If you boot
an accessory which has problems with preemptive multitasking, you can turn off the
preemptive multitasking in MAGX.INF and turn it on afterwards in the control panel
using the MagiC timeslice module “TSLICE.CPX".
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Using Long File Names with VFAT file system

MagiC adds the ability to use long file names to your ATARI computer. Using a Windows 95
compatible VFAT file system has several advantages:

* You don”t have to (re)format your hard disk
* You can directly read and write Windows 95 floppy disks and removable hard disk media
(HDDRIVER 5.0 required) on your ATARI computer.

Activating Long File Names

The MagiC install program creates the folder C:\GEMSYS\MAGIC\UTILITY where you will
find a program named VFATCONF.PRG. When you start VFATCONF, a dialog box appears,
where you can select partitions which use long file names.

VFATCONF distinguishes between permanent and temporary settings. While temporary
settings remain valid until you start the shutdown process, the permanent settings will be
saved in the MAGX.INF file and restored the next time you run MagiC.

Using Long File Names

Don“t be bothered by the fact that not all programs make use of long file names. The
MagiC file system always creates a short file name (used by old programs) when creating a
long file name. You recognize programs supporting long file names by the edit field in the
file selector which is no longer limited to 8 + 3 characters.

Deactivating Long File Names

You can always deactivate long file names without losing data (e.g. using a drive where
MagiC stored long file names on a computer without MagiC).
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The MagiC file selector is a completely new development.The following extra functions have

been implemented:
» The file selector also has an autolocator function like Read INF File .

MAGXDESK. Typing in a file name causes the selector

to find the first match.
« Folders can be opened via double-click (like in the

desktop).
« Folders are immediately recognizeable - they are

£ FHLETTEI 28.11,95
) 0ED 28,11.95
£ SCSIToOL 29.11.95
€2 SELECTRI.C 28.11.95

marked with a symbol. & ST SRR
C3 TENPLMON 28.11.95

* A double click on the parent object switches directly H & T 39,11 9%
to the root directory. |  ViREwoET . 3.8 28,1195
« Multiple file masks e.g. “*.DOC, *.BAK” or g o :““:
“* PRG,*.APP,*. TOS” etc. 1AGX . INF 2398 25.01.96
« Incomplete paths are expanded. Invalid paths are
ignored (e.g. a folder may not exist after you have

luu:liil__—__

£l

ﬂ— ﬂ
after changed disks) - it simply defaults to the root
directory.
» Any file name entered in the field is retained so that it can apply in other directories.
« The sort mode can be changed.
« The date stamp and size of files is displayed.
« The dialog box is moveable if there is enough free memory.

» You can switch to “*.*” via popup as well as other file masks. Double-clicking on the file

mask popup lets you enter your own file masks.

You can select files either with the mouse or with one of the following key combinations:

Cursor up Selects the one above
Cursor down Selects the one below
Ctrl-Cursor up Moves the scrollbar up
Ctrl-Cursor down  Moves the scrollbar down
Alt-A Change to drive A:

.. Alt-Z Change to drive Z:

Alt-Esc Reread after media change
Ctrl-D Unselect all

Ctrl-H Go to parent folder

Return OK if a file is selected. Otherwise opens folders.
Undo Cancel

There are also some special functions in programs which support MagiC:

» The file selector can run as a window (non-modal dialog) so that you have access to
other programs while the file selector is still open.

 Path history local to the program

« Apart from typing in a file name or mask, the file description can be selected from a
popup list.

« Multiple selection
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Dialogs and Alerts

You may have noticed that the dialog and alert boxes in MAGXDESK and VT52 are a little
different from the standard TOS ones.

Dialog boxes

The most obvious difference is the square in the top righthand corner (called a “dog-ear”)
which is used for moving the box around the desktop. Some buttons contain underlined
characters, radiobuttons are round (as usual on a Mac) and there are also checkboxes
(toggles). Dialog boxes can be moved in two ways:

 Click the left mouse-button on the dog-ear and hold it down. The arrow turns into a “flat
hand” with which you can then move the dialog. The dialog will be placed wherever you
release the mouse-button.

» Click and hold the right mouse-button. Then click and hold the left mouse-button
anywhere within the dialog box - it will disappear and only the outline will remain
visible. Move the dialog by dragging it to a new position and then release both buttons.

Underlined characters within dialog boxes signify that this character is the hotkey for that
element - it can be activated from the keyboard by holding down the Alt key before pressing
the respective character key. In order. to make the operation.of dialog boxes even more
comfortable we have extended the system functions. The following additions will only apply
if the program uses system functions for its dialog boxes: ~

left mouse button Position cursor exactly (even within editable fields)

Shift-Cursor up Cursor to the last editable field
Shift-Cursor down Cursor to the first editable field
Shift-Cursor left Cursor to the start of the editable field
Ctrl-Cursor left Cursor to the previous word or beginning of line
Shift-Cursor right Cursor to the end of the editable field
Ctri-Cursor right Cursor to the next word or end of line
Cir/Home Same as Shift cursor left
Shift-Clr/Home Same as Escape

Ctrl-Delete Delete to end of line

Insert Insert mode

Shift-Insert Overwrite mode

Ctrl-C Copy (line)

Ctrl-X Cut (line)

Ctrl-v Paste (at cursor position)

Undo Button “Cancel”, “Abort” etc.

Help Button “Help”

Ctrl-Q Button “Quit”, “Exit” etc.

Use of the clipboard functions (cut/copy/paste) lets you copy data from one editable field to
another (e.g. from a file selector into a dialog box). Subsequent insertion using Ctrl-V is the
same as if the data had been written in “by hand”.

Unfortunately, there are an increasing number of programs on the market which bypass
GEM and implement their own dialog routines. Many or all of the additions above may not
work within such programs. Both MAGXDESK and VT52 make exclusive use of system
routines. This means that many programs can be improved (e.g. adding hotkeys, round
radio buttons) simply by editing their resources!
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Alertboxes

Alert boxes in MagiC are usually movable. However, if there isn "t enough memory available
to support this feature, the dog-ear will be missing and the alert cannot be moved. If
(annoyingly) an alert box appears when your mouse pointer isn "t visible you can still close
the alert from the keyboard. In addition to Return for the default button and Undo or Ctrl-
Q for the “Cancel” button, the keys F1, F2 and F3 will activate the left, middle and right exit
buttons respectively. We have also added more descriptive text.

MAGXDESK Menu Structure

The MAGXDESK menu bar consists of five drop-down menus. The individual menu entries
can be activated either with the mouse or with key combinations (hotkeys) which are
indicated by symbols to the right of each entry. As there is little room to write Alt or Ctrl,
these are abbreviated according to the following convention:

A means Ctrl, # means Alt

I about MagiC... { Open AD u!cnns
1

Install Drives

--------------- Information... AI| as Text Install Application...

Delete... ADel |- 41 RAssign Icen...

' uune | Futl [ | ‘z ---------------------------
Hem Folder... AN| Single Column Preferences...
Search... AF | Shom Size Change Resolution...
Clese AH1 Shox Date Save Dptions
Close Nindow AU| Shom Time | -——==-======rmemsrmrmmmnen-
Selut All M lr-rermmconacnona Shutdosn
----------------------- by Name Fl
fnﬂut by Date Fi
Eject mm AJl by Size Fl
Copy Disk... M| by Type Fd

unsorted FS
| Set Mask... M|
MAGXDESK: about MagiC...

This shows the copyright, the MagiC and MAGXDESK version numbers and also the name
and address of the licensee.

The “File” Menu

File: Open 0
This entry can only be activated when a single desktop icon is selected. A dialog box will
open in which you can enter parameters (e.g. the name of a file for your text editor, options

for TTP program ). The dialog box will also appear when the desktop icon is double-clicked
while holding down the Ctri key. S —— =

. H 2 .ri-_ _.H'-__I. 4 : E -
| falm Infmtlm i
3 : = i 5 J
File: Information... ~l | - RISV
L] aes i = . 5 = N e e P e
.-..'.'ir.-.li'Jr' ittt R ! : :
SR S S,

This entry can only be activated when a single desktop O Name ; 4551457 N

icon is currently selected. Information is displayed di  28-11- unmuu

according to the type of icon selected (i.e. about the m’“é;@; 1’“”‘ lutu

file, folder or drive). afll!!? %h:::“ _'_* ] '
5 ’llm

Folder information resembles the following picture: idden fllu ';

- _1.-.1-_. : -

L8 T e T

The Name field is editable - you can change the name
of the folder.
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If the selected icon was a file, the information box will

riH
Ll

look a little different. The file name and its attributes af"' Infmatl&u A _....__...W o e Ej

can be changed here. e oL e
 Heme! fﬁﬁ.LUPE.ﬂM
. Size: 24243 Byte =

The Set Current Date toggle corresponds to the t".t“, .;-.;43 at 17.42 “

“touch” function found in some programs. Intelligent _1 'Set mt i“‘

compilers can be forced to recompile older source files ﬁt e _
instead of just linking the object code. Backup trlb:t:gl H_j e R
programs in incremental mode can be coerced into f 5:“" S i }

saving “touched” files. Files with the Read Only flag
cannot be deleted or changed in any way. Hidden files
are not visible in the desktop except if you have
switched on the option Show hidden files in the
menu “Preferences”. The attribute System is used for
files which belong to the operating system and should therefore not be changed.

o el Information about a drive is as detailed as should be
""‘ m‘“ o KOQ necessary. Floppy disks boot sectors are also tested to
o find out whether they are executable. If so, the disk
m “ bisk 0: MUELU o could possibly be infected with a virus (MagiC would
Folders: 168 - " "
lornltl'ilm 1816 open the alert “EXECUTABLE BOOT SECTOR”). The
~ Hidden Files: 8 || number of tracks and sectors per track are also

displayed.

If more than one object was selected as you opened the
Information dialog, you can jump to the next object by
clicking on OK. The Cancel button will also jump to the
next object, but any changes you have made to the
previous one will be lost.

File: Delete... *Del

Calling this function will delete all selected files in the topped window. This is especially
useful if the trashcan is covered by a window. This function can only be called if there are no
selected icons (anywhere) except in the topped window!

File: New Folder... A
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This will open a small dialog box with which you can create a new folder. The new folder
will appear in the currently topped (active) MAGXDESK window.
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File: Find... »

This entry is used for searching selected folders or drives for particular files. If no objects are
currently selected, the top window will be searched. Apart from normal file names or masks
(*, 7) you can also search for files according to size and/or date.

The search under MAGXDESK is handled by the utility “MGSEARCH” which runs parallel to
the desktop and any other applications you are running. This means that the file search

doesn “t block the system. All found files will be listed in the search window. An asterisk in
the title bar indicates that the search program is still working. Files in the search window
can be opened by double-clicking on them.

File: Close *"H
Changes the current path to one level higher. If you are already in the root directory, the
window will be closed.

File: Close Window *U
Closes the currently topped MAGXDESK window.

File: Select All ~A

All objects within the currently topped MAGXDESK window will be selected. If no window
is open, all the desktop icons will be selected!

Flle: Format...

Format is greyed unless a single drive icon is selected. |
If the selected drive is not a floppy disk it will notbe  {f _ S HEE
formatted but will only be initialised. A disk name can =I_-L—" .._..!E..l.mu '!g L s
be entered in the dialog box - this will appear under '
the icon when the disk is accessed.

It is always a good idea to name floppy disks if you
are not in too much of a hurry. The DD/HD buttons
set the standard values (double-side/80 tracks and 9
or 18 sectors per track) with only a single mouse-click.
Disks formatted in this way can be read by IBM-
compatible PCs or Macintosh.
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Clicking on Options will open a further dialog box for the more adventurous and
technically-minded, where interleave, offset and cluster size can be set. Custom (non-IBM-
compatible) values can be created. Note that the format routine is not able to create 11
sector formats on DD drives.

Formatting begins at the highest track - if you make a terrible mistake you can stop
formatting by pressing both Shift keys at once, and if you are lucky no data will be lost.
When an error occurs the disk should be removed from the drive because it has not been
initialised completely and will contain invalid data.

File: Eject Medium *)

This entry is only available if a single drive icon is selected. A hard disk driver with XHDI
support (e.g. Hushi or HDDRIVER 4.x - but not AHDI) is necessary for this to work. If you
own a removable hard disk with a driver which supports ejection, MagiC will stop the drive
and eject the medium.

File: Copy Disk... K

Copy Disk lets you copy from any drive with floppy-disk
icon to any other (drive A is always assumed to exist).
Clicking on the drive button will cycle through the
registered drives. If you have chosen the mode Without
Formatting, the present formats of the source and
destination disks will be compared before formatting
begins. If you only have one floppy disk drive you will
be asked to change disks. If the two formats are
different, an alert will be opened letting you either
format the destination disk to match the source disk or
abort. MAGXDESK makes use of the system formatting
routines, which means that it can "t create 11 sector
formats for DD drives.

If your computer has both a floppy disk and a hard disk, but not enough memory to be able
to read a full disk, you can still use MAGXDESK s copy program to load the disk without
having to play “disk-jockey”. Click on the Options button and enter a hard disk drive for
Temporary drive used. If there is enough room on the hard disk, the source disk will be
read completely and written to the temporary drive. You will be asked to insert the new
disk, the temporary file will be written out and then deleted. If there isn "t enough room on
the temporary drive, this will not be used and you may have to swap the disks several times.

If errors occur during formatting an alert will be opened showing the error and will give
you the following choices:

Cancel Pass on the error message, abort the function
Retry Repeat the function (e.g. after removing write-protect)
Continue Ignore the error message and carry on formatting

Retry is the default button.

If copying is aborted before it has been completed you should remove the disk from the
drive as it will contain undefined data (do not attempt to view the contents). Disk copy can
be aborted by pressing both Shift keys at the same time.
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The “View” Menu

Objects in windows can be displayed either as icons or as text (file, size, date, time). You
can also select whether the size, date and time should be displayed and also whether the

files (as text) in the window should appear in a single column or not.

View: Font... ~Z
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Clicking on this entry opens a dialog in which you can select a font and size for the
MAGXDESK text mode. If NVDI is installed, bitmap and vector fonts will be available in
addition to the standard system fonts.

Sort modes

MAGXDESK normally sorts files according to their names. Sometimes it can be more
convenient to use other methods e.g. if you are looking for the most recent file. Apart from
the criteria Name, Date, Size and Type the files can be shown unsorted. This means that
they will be displayed in the exact order in which they appear (physically) on the medium.

View: Set Mask... #M
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This is a file display filter, whereby masks can be set for each window individually.
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The “Options” Menu

Options: Install Application... #A
This is only active when a single program icon is selected (or a file which has been linked to

an application - see below). MAGXDESK starts (in parallel, of course) the desktop database
application APPLIKAT,

mg iug ir, ﬂm
| FI\ARTWORX\ARTHORX. m

Cmet WS OTS O
Start nﬂn @ progrm O i_;‘tm "

You can:

set the program type (programs registered as TOS or TTP will run in a VT52 window)

set whether a program is started in its own path (default) or in the path determined by
the top window. - set Single Mode for programs which have problems with multitasking.
When such programs are started, MAGXDESK will be unloaded and any other parallel
tasks will be frozen until the Single Mode program terminates.

set whether a program understands the message VA_START. If a program is already in
memory and you drag a file onto its icon, MACGXDESK will send the program a VA_START
message. The existing program will load the file.

limit 2 program “s appetite for memory (some reserve all the memory they can get).
create an association between various data types and a program.

set whether a program supports proportional system fonts or not.
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Double-clicking a data file will then start the program with the file name as parameter. The
two columns show the programs (left) and the associated files (right). Double-clicking a
program name opens a dialog for all related settings. Double-clicking on an icon (program
or file) opens a window showing all the available icons. Selecting an icon and dragging it
onto a program or file icon will replace the original icon with the new one. When you have
finished, click on the OK button. APPLIKAT saves all the settings, which are then
immediately adopted by MAGXDESK.
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Options: Assign Icons... #I

This entry is only available if a single icon is selected. It is used for changing the icons
assigned to programs, files, folders, drives and also the printer and trashcan. Drag the
required icon onto the icon you want to replace. Please note that assigning extra icons uses
up memory. If your computer doesn "t have much memory you should keep the number of

different icons to 2a minimum.

Options: Find Drive... #L
This function will find all the drives/partitions and will display the appropriate drive icons.
Any unwanted drive icons can be removed by dragging them onto the trashcan.

Options: Preferences... #E

This is where you can set all the parameters which affect the appearance of MACGXDESK. The
settings are divided into five different categories. Clicking on the popup lets you switch
between the various categories:

Options: General
Contains the following global switches:

« MAGXDESK resident: Normally, MAGXDESK would stay in memory so that programs
running in parallel always have access to the MAGXDESK functions. If MAGXDESK
resident is switched off MAGXDESK will be removed from memory whenever a program

starts.

Note: This behaviour can be toggled on-the-fly by holding down the Alt key when
starting a program. The setting in MAGXDESK resident will then be read as its
opposite.

» Auto Save: Ensures that MAGXDESK saves all its settings before terminating. These
include the copy mode, background pattern, the positions of all windows and desktop
icons etc. MAGXDESK will then look exactly the same as you left it (just like a real-life
desk).

» Right Mouse Button double clicks: When active a single right mouse click on an object is
handled as a double-click with the left mouse button.
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Options: Copy/Delete

This setting affects copy functions under MAGXDESK and Kobold:

Confirm Copy/Delete: Used to switch the Alert boxes on or off.
Copy Mode: See chapter “Copying, Moving and Deleting Files”
Memory Usage: Before any files are copied, MACXDESK will calculate wheter the target
medium has enough space to accommodate them.
Resident: The Copy program running in parallel with MAGXDESK can be forced to stay in
memory (needs about 35 Kb).
Kobold: The program “Kobold” will be used for all copy or move functions.
MAGXDESK checks whether a KOBOLD_2 or KOBOLD_3 is running. If you have changed
the name you will have to edit MAGX.INF with:

#_ENV KOBOLD= Full path of the KOBOLD program

Options: Utilities

Parameters concerning useful tools to add to the

| it 2 I..HJ?;. - "_'J- 3 --J----;.. |
MAGXDESK functions: ,,’"fm!' =
Gk i .-.*-*’ H_'. ' = SoTELTE .

Options: Windows
These settings affect the appearance of windows:

Editor: The full path of a default text editor which
can be started by either double-clicking a text file R
while holding down Shift-Ctrl or by pressing Ctri-E. H’Sﬂ- e :;\-7IIP\?IIP pr |
Viewer: The full path of a program which will be  Viewer: (C:\ISTGUIDE. APP
called whenever a file is opened which MAGXDESK s
can’t place (i.e. not executable and the extension is
not registered). External programs such as
GEMVIEW and 1ST_GUIDE are able to display
images and text in various formats.

Output: The program to be called when an icon is
dragged to the MAGXDESK printer icon. If the field
is empty, the file will be sent directly to the
standard printer port. Printing can be aborted at any time by pressing both Shift keys at
the same time.

Command: The full path of a Command Line Interpreter (CLI) e.g. MCMD.TOS, which
can be called directly by pressing Ctrl-B CLIs are useful for processing batch files (.BAT or
.BTP).

Show Hidden Files: Files with the “hidden” attribute
will be displayed anyway. i ——
Show TOS Files as 8+3: Determines how the names hr i - ¥

and extensions of files will appear in text mode. The || X Shos 'g mg as 'ﬂEﬁ, '. T
second version is probably better if you are using iy

proportional fonts or long file names. I"-'" i'!m“ 839 ‘"“WH
Show parent object: If you activate this option the . 371731 mﬂ“"
Closer will close the window immediately. You can e G
use the parent object to enter the parent directory.

Icon Distance: Sets the distance between icons in
windows (expressed in pixels)
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Options: Desktop

;u-umrr ol_;'

 Background: Standard settings which will be used if a background tile isn“t used in the
current resolution or if the number of colors in the tile is too large.

« Tiles: The file selector will be opened in which you can select an IMG file to be used as
the background tile. MAGXDESK supports 2, 16 an 256 colors and remembers a filename

for each color depth. Try to choose IMG files which contain the 16 system colors
otherwise your windows and color icons may well look a bit strange!

* lcon Raster: Sets the icons raster on the desktop (expressed in pixels).

» |nitialize Drive Names: Causes a search for all hard disks and RAM disks and set
their drive icons whenever MAGXDESK is started. If this is off, drive names are only

updated when a window is opened.
» Printer Icon: Show printer icon.

Options: Change Resolution
Used for setting resolution and number of colors:

320 % 24!
320 * 488
640 * 248

b4l * 480

MAGXDESK sends a “shutdown” message to any other programs in memory and then
terminates itself. MagiC is then restarted with the new settings. If you are running a
program which isn“t able to respond correctly to a shutdown message you should save your

work and quit the program first.
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Options: Save Optlons... #S
The current MAGXDESK configuration will be saved to disk.

Options: Shutdown

Select this entry before switching off the computer. MAGXDESK terminates and starts the
program SHUTDOWN which sends a “shutdown” message to each program in memory. If
there are still one or more programs in memory after a short while, SHUTDOWN shows an
error message (you would then have to terminate the program manually).

Older programs may not recognize this message, but because some of them don’t need to
save any data (e.g. the clock supplied with MagiC) - MagiC takes this into account. The file
SHUTDOWN.INF can be edited to list any programs which ignore “shutdown” and would
otherwise cause an error:

ignore CLOCK

More recent programs which don’t implement Shutdown very well can still be terminated
properly:
terminate XCONTROL

A reaction time (in milliseconds, 0 = unlimited) for programs which support Shutdown can
also be set in SHUTDOWN.INF:

timeout 10000

The “Objects” Menu

At the top there is a list of MAGXDESK windows, which can be used to switch windows very
quickly. Directly below this is a list of Programs which have been assigned hotkeys (Ctrl-F1
to Ctrl-F10 are available).

Hotkeys are assigned by clicking on New and selecting a program via the file selector.
Programs currently in the list can be changed or even removed by holding down Ctrl while
clicking in the list. A file selector is opened in which you can select a program for that
particular hotkey; deleting the editable field deletes the hotkey.
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Keyboard operations of MAGXDESK

In addition to the hotkeys for individual entries in menues, which you learned about in the
last sections, MAGXDESK also implements an Autolocator as well as some generally useful
shortcuts.

The Autolocator

Finding a particular file in a window
becomes more tedious, the more

b = B3 APESRESVDL .LIB\® - — =~ D AH
[(#LIB. H%] 4.276 Bytes in 2 selected Objects '

R

files there are in that directory. QB '; ?& m ‘
MAGXDESK has an autolocator ,. P AR N 4 -
fl’nCtion WhiCh accepts a file maSR: I W!!LII UﬂILII 5 Wl@ﬂ H WIL! LID UIJIH 5 .

Typing a space will remove the last
“*%_ This can be useful for finding
objects without extensions.

Entering special characters

Special characters which aren "t available directly from the keyboard can be entered via the
toggle Alt-Capslock. This switches into a system mode where foreign vowels etc. can be
entered normally. E becomes E and e becomes é and so on. Alt-Capslock toggles back to
normal.

Keyboard Operations

Esc The directory index of the active window is updated.

Undo The active window will switch directly to the root directory.

Tab The same as Ctri-| (file/folder/drive information).

Backspace One directory level upwards (“climb the tree”). If the active window is
already in the root directory this key will be ignored.

Insert The same as clicking on the the active window ’s sizer.

Home Moves the scroll-bar to the top.

Clr Cir (Shift-Home) moves the scroll-bar to the bottom.

Cursor up

Cursor down Line by line scroll in the active MAGXDESK window.

Shift-Cursor up

Shift-Cursor dn Pagewise scroll in the active MAGXDESK window.

Spacebar Deselects all objects

Alt-Shift a-z Opens a new window (root directory of the drive)

Ctri-Shift a-z Changes the drive of the active window (root directory).

Ctrl-B Starts the Command Line Interpreter (as set in Options: Utilities in

the MAGXDESK menu) with no parameters. The same program can be
started in different “instances”. The working directory will be the same as
the active window.

Ctrl-E Starts the standard editor with no parameters. The working directory
will be the same as the currently active window.

Ctrl-W Cycles through the open windows. Ctrl-W may have to be pressed
several times before the required window is topped.

Alt Generally means “in addition”: Holding down the Alt key while

closing a window via the Closer or Backspace opens a window one
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directory level higher without closing the original one. Analogously,
Alt-click on folders opens a new window without closing the original
one. Starting a program while holding down the Alt key effectively inverts
the state of the switch Options: General: MAGXDESK resident (see
above).

Ctrl If Ctrl is held down while a window is being closed, the window will be
closed completely.

Peculiarities of Icon Operations

The basic icon operations in MAGXDESK are similar to those you will already know from TOS
or other alternative desktop programs:

» Asingle click on an icon selects it and any other selected icons are deselected. More than
one icon can selected if Shift is held down.

» A set of icons to be moved must all be either desktop icons or window icons i.e. both
types cannot be moved at once.

« Holding down the right mouse-button lets you work objects which are not in the active
window.

« Aclick in an unused area of a window will deselect all window icons. Selected icons
remain so even if the window is scrolled, moved or sorted differently etc.

An annoying behaviour of other alternative desktops is that if you happen to click on an
unused area of the window by accident while selecting several icons (with Shift), all icons
are deselected. MACXDESK has been programmed so that all icons remain selected. If you
click on a selected icon while holding down Shift this will be deselected. The MAGXDESK
version of the GEM “rubber band” works the same i.e. all icons crossing the rubber-band
area will have their selection-state inverted.

Sending Parameters to Programs with MAGXDESK

In addition to the usual drag & drop method of sending file names to a program
MAGCXDESK also allows files from different directories to be sent. Typical Example: You want
to compare two files from different directories using a program which takes the two file
names as arguments. This can be achieved by selecting the two files with Shift-click and,
keeping Shift pressed, double-clicking the program icon. If you proceed as above but also
hold down the Ctrl key while starting the program, all selected icons (from all windows and
from the desktop) will be sent as parameters but will be diplayed in the parameter list first
so that the list can be edited if necessary.

If you want to start the standard editor (Options: Preferences: Categorie Utilities) with
only one file as parameter, this can be achieved by double-clicking the file icon whilst
holding down Ctrl. If you want to edit more than one file from different windows, any one
of the file icons can be doubleclicked whilst holding down Shift-Ctrl.

By the way, MAGXDESK prevents a program already in memory from being loaded again
and sends a message (VA_START) to the existing program. This message tells the program
that it should load the new files in the parameter list (in addition to any files already being
edited). Some older editors do not understand this message - you are forced to load files
from within the editor in the normal fashion.



34 MGNOTICE

MGNOTICE

MGNOTICE draws and manages notes and displays them in windows. Start MGNOTICE via
double click or put it in the start folder (/gemsys/magic/start/). All notes will be saved in
/gemsys/gemdesk/notice/. This folder will be created automatically, if it does not already
exist. The INF file will be saved in the HOME path of the system (if no HOME environment
is.set, MGNOTICE will use the current directory to save the INF file).

How to write a note
Select File: New. Type the note and press ESC to leave the edit mode. The note will be saved
immediately. Changed window positions will be saved when the system is shutdown.

Changing fonts and colours
Double click on a note to select it - a cursor appears in the selected note window. Now you
can change the font and colour properties. The changes will be saved immediately.

Deleting notes
Double click on a note - a cursor appears in the selected note window. Choose File/Delete

to delete the note.

Changing notes

Double click on a note - a cursor appears in the selected note window. Now you can change
the selected note. Press ESC to leave the edit mode. The window size adjusts automatically
to fit the new text.

Moving notes
Click on a note and move it.

The VT52 Menu Structure

In a multitasking environment, TOS and TTP programs must be routed to windows so that
they will run in parallel without hogging the whole screen. This routing is handled by VT52.
The VT52 menu bar consists of five dropdown menus. The individual entries can be selected
either with the mouse or via hotkeys:

.+ B0 | Paste ®V] Cycle Mindows | Clipboard... BC
"""""""" Terninal... ar
1] Progran Ternination... ®P
"""""" Font... 8l
M| 0 [peeececcccccccccccacscccaces
Save Parameters... !S-‘

VT52: About VTS2...
Displays copyright information and the VT52 version number.

The “File” Menu

File: Open... #0

TOS and TTP programs are automatically redirected into VT52 windows if they are started
via MAGXDESK or an alternative desktop which has been adapted for use with MagiC. If
your desktop doesn "t support MagiC fully or if you want to start multiple instances of a

TOS/TTP program, you can load the program(s) with this function. Note that multiple

instances of the command line interpreter can be loaded directly by pressing CTRL-B in
MAGXDESK.
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File: Close... #U
Terminates the program and closes the VT52 window.

Flle: Quit #Q

This function terminates all TOS programs (if possible), closes their windows and removes
VT52 from the system.

Note: If you are running programs which divert system vectors but don "t support the

XBRA process, VT52 might not be removeable (you will get an error message to that
effect). In such cases VT52 simply remains in memory.

Copy & Paste

Marking Text (Copy)

The standard GEM method of selection (select with the mouse, save to the clipboard via
“Copy” is not very suitable for text in VT52 windows. Blocks are marked in VT52 by holding
down the left mouse button and “wiping” over the text. The mark is completed and the text
is copied automatically to the clipboard as soon as the mouse button is released.

Edit: Paste #V
Inserts the contents of the GEM clipboard data to the current cursor position.

Window: Cycle Windows #W

Activates the next VT52 window (if there are more than one).

The “Options” Menu

Options: Clipboard... #C

This opens a dialog box used for setting the way line delimiters and control codes are
handled during copy and paste.
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Such conversion can be very useful if you want to export data to other systems e.g. Unix
uses a single LF (linefeed) as delimiter. Also useful if you are running certain GEM programs
(e.g. editors which don "t interpret control codes).
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Options: Terminal... #T

Selecting this entry opens a dialog box in which
several parameters concerning the terminal can be
set.The upper box is used to set the size of the terminal f§ [ *
window in characters (Columns and Rows) and the I | Gol
number of lines of output which will be buffered. This

buffering is useful if the output of the program is
longer (in lines) than the height of the terminal - the
text can be scrolled back into view.

If Buffered Output is switched on, the TOS program
will carry on running even if its output is blocked (e.g.
by another programs output and a modal dialog box).
The output is written to a buffer and will be displayed
as soon as the screen is free again.

Input line Visible ensures that input is always scrolled into view. Timer Redraw is used to
set the interval between attempts to to update the terminal window (500 ms is usually
about right).

Options: Program Termination... #P

This regulates how VT52 behaves after all TOS/TTP programs are terminated and whether
the windows belonging to terminated programs should be closed immediately.

Options: Font... #Z
This opens a dialog used for selecting the font and point size for the text in all terminal
windows. Displays a list of all non-proportional fonts.

‘Options: Save Parameters... #$

The current VT52 configuration can be saved to a file called VT52.INF. Parameters included
are the window position and size, the font and the paths of all currently active TOS/TTP
programs. In other words: You can set which programs should be started automatically
whenever VT52 is loaded! A more detailed description of VT52.INF can be found in the file
VT52_EX.INF (which you will find in the UTILITY folder).
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Tuning

WBDAEMON - Write Back Cache

WBDAEMON is the name of a particularly effective method of speeding up access to hard
disks and floppy disks, especially during write operations. The principle is based upon the
(e.g. Unix) method of delaying write operations until the processor is not being used much.
Further changes to data doesn "t have to written to disk but can be read directly from the
(much faster) volatile memory in the computer. Only if no changes are being made for a
certain time will the disk be updated (in one go). Installation: Copy the program
WBDAEMON (“Write Back Demon”) into the START folder (/gemsys/magic/start) and
restart the system.

We recommend reserving plenty of memory for the cache (even for floppy drives). That
doesn 't mean that you have to reserve 2 Megabyte (like in some computers we know!) -
between 5 and 20 sectors should suffice for the FAT. The smaller the files being copied or
deleted, the more adavantage you will have from using WBDAEMON.

Make sure that the cache has been written completely to the floppy disk or other
removeable medium before changing the disk. You should wait until the light belonging to
the drive turns offf - you probably do this anyway. Furthermore, you shouldn“t simply
switch off the computer when you want to end a session. The safest method of terminating
the system is via the Options menu in MAGXDESK.

The risk of losing data is extremely low because the cache is always written to the medium
within two seconds after the last access. You can even quit WBDAEMON via the program
manager (Ctrl-Alt-Esc) without risk.

Appendix

The following two chapters are not aimed at the average user, but should be of interest to
advanced users looking for further insight into the system.

The Program Manager

All important functions concerning application management can be called very easily by
opening this popup. Further settings requiring sound knowledge of the system (e.g. for
fault finding) are also available here, hidden from the average user. Whenever a program
makes an AES call or is waiting for an event, the key combination Ctri-Alt-Esc will open the
program manager.

Unlike the popup menu, this is also possible from within modal dialogs (e.g. alerts).
Caution: The program manager should not be called from within the text editor “Tempus”
as this program hooks itself into too any critical interrupts and can cause the system to
crash. All registered applications are displayed as a line containing the following
information:

» Application number (ap_id): This is the number retrieved by appl_init(), to be found in
global[2]. Unlike TOS, not all numbers have to be present because applications are
created and deleted dynamically. The main application always has the ap_id number O
under MagiC and all TOS versions, while the screen manager has the number 1. Unlike
under TOS, programs running under MagiC can have IDs other than 0.
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» Application Name: This is the name under which the program has been started. It is used
for finding an ap_id via appl_find(). The name is always written in capitals in MagiC.

« Application Status: “running” means that the program is currently active. “ready” is a
program which is not waiting for input and will continue shortly. “waiting” applications
are those which are waiting for input from the user or other events. The actual events
waited for are shown as two letter abbreviations:

kb Keyboard

bt Mouse button

m1  First mouse-rectangle

m2  Second mouse-rectangle
ms Message

ti Timer

se Semaphore (wind_update)

“frozen” programs have been stopped - either by another application running in single
mode or by use of the “F” key in the program manager. “zombie” programs are waiting
to terminate! They cannot be manipulated in any way and will be removed from memory
at the next opportunity.

* Response to events: MENU means that the respective application is the one whose menu
is currently active (and will thus respond to menu messages).
MOUSE means that mouse button messages and mouse movement is sent to this
application. Both TOS and MagiC will only let a single application respond to mouse
events. The respondent is either the program to which the topped window belongs or
the program which has reserved keyboard and mouse control by way of a GEM system
call (BEG_MCTRL). If you click on the desktop background and the corresponding
application is waiting for mouse events, it will receive them.
However, mouse control still belongs to the topped window, which is why the
application to which the desktop belongs might have to call BEG_MCTRL (e.g. to move
icons).

KBD is similar to MOUSE - all keyboard events are sent to the application whose window
is topped. SCR is the screen semaphore, meaning that the program has reserved the
screen via [wind_updat()], locking all other output.

« Memory used:
The amount of memory used by application number 0. If a program has been loaded
from “within” another, this value is the memory used by the child application.

» For Programmers: The program manager is useful for finding the cause of “deadliocks”. A
classic example is the following:

0 PROGRAMM waiting kb bt SCR
1 SCRENMGR waiting se MOUSE KBD

PROGRAMM waits for keyboard and mouse events which have been sent to the screen
manager (SCRENMGR) instead. SCRENMGR is waiting for the screen to be released (it
was locked by PROGRAMM).

Hitting Return after selecting a different program is the same as switching programs using
the popup menu.
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The key “C” can be used to hand over both keyboard and mouse control to an application,
thus releasing the deadlock. The culprit is always a missing call to
“wind_update(BEG_MCTRL)"” in an application.

The keys “F” and “U” freeze and thaw applications respectively. In effect, this is the same as
starting programs in Single Mode. The program is halted and cannot be started until it is
thawed with “U”. Programs which hook into any system vectors cannot be removed
properly. The text editor “Tempus”, for instance, doesn’t take to being frozen at all (while
cleanly written GEM programs don "t cause any trouble). A frozen accessory doesn "t
respond - its place in the menu is greyed.

Removing normal programs can also prove critical because the application would be
aborted without its “consent”. Quitting “dirty” programs is often only possible because
MagiC goes to such length to clean up afterwards! However, programs which circumvent
GEM too much (like “Tempus”) cannot be terminated. The only sure medicine against these
problems is trial and error.

If a dialog or menu is open when you attempt to start the program manager via Ctrl-Alt-Esc,
and memory is in short supply, the contents of the screen may become messy. This is only
temporary - quitting the dialog or menu will cause the screen to be redrawn.

Drive U

You may have noticed the drive “U” in the MagiC file selector and Desktop. This is not really
a drive like A or C but is a “pseudo drive” with several special features explained below.
Open drive U:, You will see the following directories/files:

« The DEV directory
This directory contains pseudo files which represent devices and interfaces. The list of
files will differ, depending upon the hardware in your system (TT/Falcon or ST).
Additional device drivers can be installed here to ensure standard access to interfaces
and external devices. Installation of such drivers is described in the MagiC Developers
Guide. If, for instance, you save a file to U:\DEV\PRN, this will be sent to the parallel
printer port.

« The PIPE directory
This directory contains objects which can be used for transferring data between
programs. The directory is also used for “drag and drop”. Please read the MagiC or MiNT
documentation for developers if you need more detailed information on this subject.

« The PROC directory
This contains a list of all the (running) programs together with their start times and use

of memory. Deleting a “file” will terminate the program (brutally). Please aviod using
this method.

« The SHM directory
Management of shared memory. See the MiNT documents for more info.

« Each drive recognized by the system is represented by a directory or a 0-byte file. The
directories can be opened and you can work with them just like drives in the desktop.
The path “u:\c\bin” is practically another way of writing “c:\bin”. Invalid drives (e.g. no
medium in the drive) appear as empty files. These are symbolic links to the root
directories of all drives.
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